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What can you accomplish with Nexus 
Copy Number?

• Incorporate samples from various array platforms into 
a single project

• Identify common areas of aberrations across your 
data set

• Identify genes and GO terms in aberrant regions



Additional Features in Nexus Copy Number 
Professional

• Incorporation of external data such as miRNA and gene 
expression

• Statistical class comparisons

• Enrichment analysis

• Identification of natural grouping of samples via clustering

• Identify regions correlated with continuous valued phenotypes 
(e.g. survival)



What Will Be Covered?

• Copy number analysis basics; Segmentation and Allele 
Specific computation

• Basics of loading, processing, and viewing results

• Settings

• External Data

• Clustering

• Comparisons



DNA Copy Number Analysis Workflow

Image 
Processing

• Convert image intensity values (pixels) into signal strength
• Perform basic QC test and remove “bad” spots

Single Sample 
Analysis

• Pre-process data and identify regions of copy number 
change (segmentation)

• Measure QC based on probe-to-probe variations
• Visualize the result for a single sample

Population 
Analysis

• Integrate data from many arrays
• Identify areas of common aberration
• Identify genes and biological pathways being disrupted
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Image Processing

Demonstration using ImaGene version 8



Load Image and Place Grid



Quantify Spots & Perform QC



Save & Visualize Data



Walk-Away Batch Processing



Section 1: Identification of Copy Number 
Change Events

Segmentation Algorithm



Mapping Spots to Regions on Chromosome

Array

Chromosome

Probes can be BACs or Oligos



Computational Challenges

• Experiment results in a table:

Probe 
Location

Expr. Control Ratio Log Ratio

Chr1:10-20 150 100 3/2 +0.57

Chr1:50-60 300 200 3/2 +0.57

Chr1:70-90 500 500 2/2 0
Chr1:100-120 60 60 2/2 0

Chr1:250-300 500 1000 1/2 -1

0
+0.57

-1



Segmentation Algorithms
• Many different algorithms have been proposed by 

industry and academics
• Range from simple approaches based on z-score to 

model based statistical approaches
• BioDiscovery has developed its proprietary rank 

segmentation algorithm based on a well accepted 
Circular Binary Segmentation (CBS) algorithm

• CBS was found to be a superior method to a number of 
other popular methods in paper by Willenbroc & 
Fridlyand, Bioinformatics, 2005

• Rank Segmentation performed very well in a number of 
recent comparison papers



Recent Comparisons
• Paper suggest a new algorithm, Birdsuite, for Affy SNP6 

processing involving creating probe-specific models



Comments on Paper

• The birdsuite algorithm used here was optimized for 
SNP6 processing and optimal parameters were used

• Algorithm took advantage of genotype calls and B-allele 
values not just log-ratios

• Nexus parameters were default values and not optimized

• Nexus only looked at log-R values

• Settings reported requiring a minimum of 5 probes per 
call



Another Recent Comparison Paper

Poster presented at ASHG 2008

Method comparison: ROC curves (sensitivity vs. 1-specificity) for each method on the 
3 databases. Nexus and QuantiSNP are consistently best across datasets. CBS and 
GLAD are good, but limited in range of sensitivity. The performance of PennCNV was 
not consistent across datasets.



BioDiscovery’s View on Segmentation Algorithms

• We strive to develop good quality and reliable segmentation 
algorithms 

• Our goal is to create algorithms that work across many platforms

• We use real-world assumptions in the algorithm (e.g. mosacism 
does exist in real samples)

• We do not intend to “compete” with segmentation algorithm 
developers

• Nexus’ main goals are post segmentation analysis



Rank Segmentation Algorithm

Overview



Segmentation

1. Sort probes based on log-ratio values and give each 
probe their rank as the score

2. Recursively segment each chromosome to identify 
segment boundaries that separate two adjacent 
segments with a giving significance level



Settings Window: Analysis Panel

• Significance Threshold 

• Max Contiguous Probe Spacing

• Min Number of Probes per Segment

• High gain

• Gain

• Loss

• Big Loss



Significance Threshold
• For adjusting the sensitivity of the calling algorithm 

• Smaller number = more stringent before creating a 
new clusters. 

• Significance threshold should be set based on 
expected noise.  

• For oligo arrays, we recommend using 1x10-6

• For BAC array (lower density), we recommend 5x10-5



Effect of Significance Threshold

Significance = 1E-8Significance = 1E-5



Thresholds for Making Calls

• High gain – Two or more copy gain

• Gain – Single copy gain

• Loss – Hemizygous loss

• Big Loss – Homozygous loss



Calling Thresholds



Max Contiguous Probe Spacing

• Specifies the maximum spacing between adjacent 
probes before breaking a segment. 

• Especially useful for 
– areas across the centromere where software will not make 

any calls where there are no probes 
– focused arrays where there are probes only in parts of the 

chromosome 



Maximum Contiguous Spacing

>1MB



Min Number of Probes Per Segment

• Sets the minimum number of probes used to make a 
call 

• Useful to prevent creation of a segment based only 
on a few probes in a region



Robust Variance Sample QC

• Calculates the probe to probe variation across the 
genome

• A single parameter is used to remove extreme outliers 
that one would expect to be due to copy number 
breakpoints.



Example QC Scores

QC Score = 0.012QC Score = 0.224



Gender Specific Cutoffs
• New in version 4, if factors Gender and Control Gender

are defined with values (Male or Female), the thresholds 
for the sex chromosomes are automatically set

• For example of sample is Male and reference is Female, 
the no change value for X chromosome



SNPRank Segmentation

Combining B-Allele Information with Log Ratio



Background

• Applicable only to SNP Arrays, e.g. Illumina and 
Affymetrix arrays

• Current support is provided for all Illumina arrays 
processed in Beadstudio so the column B-Allele Freq. is 
available in the output

• Affymetrix SNP 6 arrays processed through GTC yield 
.CNCHP files that contain B-Allele difference values that 
Nexus maps to B-Allele Freq

• Supported using custom data type to import pre-
processed data



B-Allele Freq. Bands

AABABB
Father: AABABBBABABBBAAAABABB
Mother: ABBABA      ABBABBAAA

AA AB BB AA BB AB B A B A B B AB AB AAA AAB BBB AAA ABB ABB

0%

100%

Normal LOH Imbalance



Allelic Loss Allelic Imbalance

Normal

LOH Total Allelic 
Loss Allelic Imbalance

Gain

High Copy Gain X X

One Copy Gain X

Loss

One Copy Loss X

Homozygous Loss X

Normal X



SNPRank Paramteres



Detection of Homozygous Regions



Section 2

Basics of Loading and Processing Data



What this Section Will Cover

• How to load data – demonstrate using a project 
containing samples from two array platforms

• Get an overview of the parameters for processing data

• Look at areas of common aberrations

• Generate graphical figures and reports



Some Common Data Types

• Affymetrix 
• Agilent FE
• BlueFuse
• GenePix
• Illumina
• ImaGene
• NimbleGen



How to Load Data into Nexus Copy Number

• New in version 4, there are two methods for loading data
– Load Descriptor: Select a file that contains all relevant 

information
– Load Data: Use a file chooser to select the raw data files

• Load Data option is appropriate when no clinical factors 
are available



The Sample Descriptor

• A tab-delimited text file specifying sample names, any 
associated clinical data (Factors), and the location of the 
raw input files

• Needed to load raw data into Nexus Copy Number

• One sample descriptor file per data type

• To load multiple data types (e.g. Affymetrix, Illumina) into 
one project, create a sample descriptor for each data 
type



Factors

• Any clinical data associated with a sample. E.g. Sex, 
age, tumor type

• Each sample can have an unlimited number of 
Factors

• Optional

• Can specify in sample descriptor or enter manually in 
the Data Set tab



Sample Descriptor Templates

• Template files for the various Data Types are 
available in the ‘Templates’ folder in the 
installation directory

• Open the appropriate template in Excel

• Populate it and ‘Save As’ in another location



Support for Dye-Swap Experiments
• New in version 4, you can indicate “replicate” arrays



Importing Other Data Types
• Open the file called customdatatypes.txt in the Nexus 

Copy Number installation folder and edit it



Creating a Project

• Specify project name

• Select location of project

• Specify organism and build so that correct 
probemappings are loaded

• Click ‘Create’



Defining New Organisms

• It is simple define new organisms by creating a new 
folder in the C:\Program Files\BioDiscovery\Nexus 
4\Organisms folder

• Define probe locations and genome annotations (e.g., 
genes, miRNA, GO terms, etc.)



Loading Data

• Click on “Load Descriptor” and select the sample 
descriptor file

• Once data is loaded, each sample shows 
“Unprocessed” in the “Status” column

• Click “Load Descriptor” again to load additional 
samples in other sample descriptor files



Processing Data

• May need to adjust Settings

• Click “View” to process selected samples. Once 
processing is complete, results are displayed 
automatically



Results

• See graphical output in the Genome, Chromosome, and 
Summary tabs

• View numerical output in the Table, Aggregate, and 
Aggregate Participation tabs



Genome/Chromosome Tabs

• Sort samples

• Zoom in and out

• Sample Drill-down

• View annotations within the application or link out to 
external databases

• View by Factor Aggregates



Individual Sample Drill Down

• Ideograms, summary aberration plots, and 
numerical reports on individual samples

• Overview plot of gains and losses

• Annotation tracks

• Numerical reports with aberrant regions, cytoband 
location…



Saving Images and Exporting Reports

• Save images to file or copy to clipboard (options 
under Options menu)

• Print

• Export numerical data as tab-dilimited text files



Additional Features in Nexus Copy Number 
Standard Edition

• New in version 4 – Query tool
– Sear for one or more genes, regions, etc. with in the project
– Returns the status of each sample for each query term as well as 

aggregate summary

• Aggregate table
– Identify regions of change in a set percentage of population
– Identify minimum common areas (Peaks only switch)
– Identify “significant” regions using the frequency p-value 

calculated based on the STAC algorithm



Section 2

How to Integrate External Data into Nexus 
Copy Number



What is External Data?

• miRNA data

• Gene expression profile data



What can you do with it?

• Overlay expression results with copy number changes 
and view alongside each other

• Identify regions of “hot spots” where the correlation of 
differentially regulated genes falling in aberrant 
regions is significant (p-value) 



What this Section Will Cover

• Expression Analysis using Nexus Expression

• Acceptable formats for loading data

• How to load expression data from an array or data 
from a published paper

• How to view and interpret the results



Gene Expression Analysis

General Overview



Information Flow
Biological Samples Arrays

Sample ID Treatment Time
Sample 1 Treated 0 hr
Sample 2 Untreated 0 hr
Sample 3 Treated 24 hr
Sample 4 Untreated 24 hr

Probe GeneSymbol Bio Proc
Probe 1 ABC Growth
Probe 2 SDF2 Decay
Probe 3 QRT Growth
… … …



Hybridized Array Integrated Phenotypes with Genotype

Probe ID Cy3 Strength Cy5 Strength
Probe 1 5000 2000
Probe 2 340 500
… … …

Probe ID Cy3 Strength Cy5 Strength
Probe 1 5000 2000
Probe 2 340 500
… … …

Probe ID Cy3 Strength Cy5 Strength
Probe 1 5000 2000
Probe 2 340 500
… … …

Model



Results of the Computation
Samples

Probes

Probe 
Annotations

Sample Annotations



Objective of Gene Expression Analysis

• What genes are expressed differently between different 
samples
– E.g. Genes that are significantly up regulated in lung cancer vs. 

breast cancer

• What do these genes do? Are there common biological 
themes



Experimental Setup
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Nexus Expression Computation

• Transform measurements of probes on arrays to 
measurements of probes per sample

• Can remove batch effects in the process

• Estimate probe variance

• Comparisons are performed using a t-test of the results
– FDR Correction
– Pooling of variances based on intensity



Required Files
• Array Descriptor

• Sample Descriptor

Data Type: GenePix Array Type: Agilent/HG44K
Array File Channel 1 

Sample
Hyb Month

Array 1 C:\Data\array1.gpr Sample 1 June
Array 2 C:\Data\array2.gpr Sample 1 July
Array 3 C:\Data\array3.gpr Sample 2 June
Array 4 C:\Data\array4.gpr Sample 3 June
Array 5 C:\Data\array5.gpr Sample 4 July
Array 6 C:\Data\array6.gpr Sample 4 July

Sample Grade
Sample 1 1
Sample 2 1
Sample 3 3
Sample 4 3



Expression Analysis Data Flow

Load Arrays

Process the data

Create comparisons

Assign 
factors/phenotypes to 

samples

Filter probes

Identify differentially 
regulated probes

Identify perturbed 
pathways

Nexus Copy Number

Nexus Expression



Input File Format

• Gene Identifier 
– Input file contains Gene Symbols

• Probe Identifier
– Input file contains Probes
– Extension of Gene Identifier format. 
– Not used commonly



Input File Containing Gene Identifier

• Required columns: Gene Symbol, Regulation

• Optional columns: p-value, log-ratio



Input File Containing Probe Identifiers

• Required columns: Probe, Regulation

• Optional columns: p-value, log-ratio

• Also need a probe to gene symbol mapping file placed in 
the ProbeSymbolMappings folder

• Need to edit mappingdescriptors.txt file in 
ProbeSymbolMappings folder to specify where to locate 
the mapping file and to indicate columns used in the 
mapping file



Input File Columns/Fields

• Regulation – possible values: up and down. Anything 
else in place of these values will mean no change.

• p-value and log-ratio – If present in input file, value will 
be displayed when moving the mouse over the 
expression data track tick marks in the 
Genome/Chromosome tabs



Probe Identifier File Format - Additional 
Requirements

• Probe to gene symbol mapping text file in ProbeSymbolMappings
folder

• mappingdescriptors.txt file in ProbeSymbolMappings folder



Loading External Data 

• Within External Data tab

• Click Add button

• Select files to load



External Data Tab

• Contains sub tabs, one for each external data 
type. E.g. Expression, miRNA

• Each sub tab
– Lists all external data files loaded into project

– User selects what to view by marking off “up” and 
“down” checkboxes

– Can edit Description column to add a description for 
each external data file that was loaded



Viewing Results - Graphical

• In Genome/Chromosome tabs, select Expression from the View
menu

• One track for each external data file

• Up-regulated in magenta

• Down-regulated in blue

• Move mouse over tick marks to display name and  additional info. 
such as p-value, log-ratio when available



Viewing Results - Numerical

• Expression p-value column in Aggregate tab

• Expression tab in Enrichment results

• Expression p-values tab in Annotation window

• Expression p-values tab in Comparison window



Expression tab in Enrichment results

Term External data file name

P-value Significance of these genes being differentially 
regulated and appearing in this aberrant region.

Q-bound FDR-corrected (for multiple testing) p-value

Present The number of differentially regulated genes 
present in this external data set that are located 
in this aberrant region

Total Total number of genes in the external data file



Expression p-values tab in Annotations Window

Comparison External data file name

Total Genes Number of genes in this region

Diff. Regulated 
Genes

Number of differentially regulated genes 
located in this region

P-value Significance of these genes being 
differentially regulated and appearing in 
this aberrant region.



Section 3

Clustering



What is the Purpose of Clustering?

• To discover natural groupings in a set of 
samples without prior knowledge of any class 
labels 

• Can help determine what factors are affecting 
certain phenotypes



What this Presentation Will Cover

• Available clustering algorithms in Nexus Copy Number

• Dendrogram 

• Factor enrichments within clustering analyses



Clustering Settings

• Available from the Options menu (Options -> Clustering 
Settings)

• Clustering window has
– Clustering algorithms
– And associated parameters



Clustering Algorithms and Parameters

• K-means
– Ignore sex chromosomes
– Cluster count

• Average Linkage Hierarchical
– Ignore sex chromosomes

• Single Linkage Hierarchical
– Ignore sex chromosomes

• Complete Linkage Hierarchical
– Ignore sex chromosomes



Dendrogram
• Drawn if using a hierarchical clustering algorithm

• Can adjust cluster count

• Can label ends of tree branches with factors

• Dendrogram image can be printed or saved as an 
image file

• Dendrogram for a previously performed clustering 
analysis cannot be re-drawn within Nexus Copy 
Number



Saving Clustering Results

• Can save clustering results by 
specifying a result name and 
cluster prefix

• A new column specifying which 
cluster each sample belongs to 
is added to Data Set tab

• Clustering column headers 
have blue background



Numerical Clustering Results in Data Set Tab

• Right click on column header to get additional options
– Details

• shows algorithm and parameters used for this 
clustering analysis

– Factor Enrichment 
• provides statistics on the number and percent of 

samples present in each factor value group within 
each cluster

• provides a p-value for the likelihood of these 
samples clustering into the particular cluster by 
chance.



Graphical Results

• In Genome/Chromosome tabs

• View -> Factor Aggregates



Section 4

Comparisons



What Can We Learn From Performing 
Comparisons?

• See differences between two sets of samples in a 
project

• Find regions that are significantly different between 
the two groups



What this Presentation Will Cover

• Different comparison types

• How to create a comparison

• How to view and interpret the results



Comparison Types
• Avg. of others - One factor set is compared to the average of all the 

other factor sets

• Sequential - Compares each factor set in a list to the subsequent factor 
set in the list

• Paired – Pairs up specific factor sets for comparison

• Selected – Pairwise comparison of a factor set with each other factor set

• Custom – Compares one factor set to average of user-selected factor 
sets



Comparisons Tab

• Create/Add comparisons

• Delete comparisons

• Edit comparison names

• View details of which samples belong in each group 
being compared



Graphical Results

• Genome/Chromosome tabs in Comparisons window

• Frequency plot of each group in bottom panel

• Top panel shows frequency difference between the two groups in a 
Comparison 
– red = loss regions
– green = gain regions



Frequency Difference Plot

• Gain magnitude of first group > gain magnitude of second group, 
difference plotted in green above 0 baseline

• Gain magnitude of first group < gain magnitude of second group, 
difference plotted in green below 0 baseline

• Loss magnitude of first group > loss magnitude of second group, 
difference plotted in red below the 0 baseline

• Loss magnitude of first group < loss magnitude of second group, 
difference plotted in red above the 0 baseline



Significant Track

• Green bars represent gain regions where difference is significant

• Red bars represent loss regions where difference is significant

• Based on p-value threshold and differential threshold (minimum 
percentage difference)



Numerical Results 

• Table in the Regions tab 

• Contains the regions which meet both the 
Differential Threshold and the P-Value 
Threshold

• P-value from Fisher’s Exact test



Wrap Up

• Many other features not covered here

• Online training seminars on various topics

• Join User Forum for important announcements including 
training webinars:

http://www.biodiscovery.com/index/siteforum-app
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